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Lab 04 - Debug 
 

Overview 
 
This module teaches you how to debug a CL and ILE RPG program.  

Learning objectives 
 
You will learn how to start the debugger, set breakpoints, monitor variables, run, and step into a program, 
view the call stack in the Debug view, remove a breakpoint, add a memory monitor, and set Watch 
breakpoints and all from the Debug perspective. 

Skill level and prerequisites 
 
Introductory. 
 

 

Important! 
 
You should complete RDi Lab01 ‘Getting started’ before you work on this lab.  Lab01 
contains the following information and instructions: 

• Which IBM i server to connect to 
• Which User ID to use 
• How to start RDi, create a connection and connect 
• How to setup the correct library list for this lab 

 
Knowledge of basic Microsoft Windows operations such as working with the desktop, mouse operations 
such as opening folders and drag-and-drop is assumed.  It will also be helpful if you understand DDS and 
ILE RPG. 
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Conventions used in this workbook 
 
Bold font   is used to highlight user interface controls 
Mono-spaced font is used for user input text and code blocks 
Italic font   is used for variable names and glossary terms 
 
The following icons are also used to identify categories of information: 
 

Icon Purpose Explanation 

 
Important! 

This symbol calls attention to a particular step or command. 
For example, it might alert you to type a command carefully 
because it is case sensitive. 

 
Information This symbol indicates information that might not be necessary 

to complete a step but is helpful or good to know. 

 

Trouble-
shooting 

This symbol indicates that you can fix a specific problem by 
completing the associated troubleshooting information. 

 

Client System requirements 
 
The labs require IBM Rational Developer for IBM i (RDi) to be installed on your workstation. If you do 
not yet have this, you can download it for free from http://ibm.biz/rdi_trial.  
 

Host System requirements 
 
The easiest way to ensure you have everything you need, is to use the demonstration IBM i server that is 
set up and ready to use with these lab exercises. These labs use the RSELABxx library on that system. For 
those who want to run these labs on to their own system, you can load a SAVF with the RSELABxx 
library from rselabxx.savf. 
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1 Introducing the Integrated IBM i debugger 
 
The Integrated IBM i Debugger is a source-level debugger that enables you to debug and test an 
application that is running on an IBM i system. It provides a functionally rich interactive graphical 
interface that allows you to: 
• View source code or compiler listings, while the program is running on an IBM i host. 
• Set, change, delete, enable and disable line breakpoints in the application program. You can easily 

manage all your breakpoints using the Breakpoints view. 
• Set Watch breakpoints to make the program stop whenever a specified variable changes. 
• View the call stack of your program in the Debug view. As you debug, the call stack gets updated 

dynamically. You can view the source of any debug program by clicking on its call stack entry. 
• Step through your code one line at a time. 
• Step return, step into or step over program calls and ILE procedure calls. 
• Suspend program execution and get control back to the debug session. 
• Display a variable and its value in the Monitors view. The value can easily be changed to see the 

effect on the program’s flow. 
• Locate procedure calls in a large program quickly and easily using the Modules/ Programs view. 
• Debug multi-threaded applications, maintaining separate stacks for each thread with the ability to 

enable and disable any individual thread. 
• Load source from the workstation or a different IBM i system than the one the program runs on – 

useful if you don’t want the source code on a production machine. 
• Debug client/server and distributed applications. 

 
The Debugger supports RPG/400® and ILE RPG, COBOL and ILE COBOL, C, C++ and CL. 
 
Now that you know the basic features of the debugger, let’s try them out. 
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2 Starting a debug session using a service entry point 
 
You will be working with the ILE RPG program PAYROLLG. 
 
The instructions for creating a connection to the IBM i system are contained in Lab01 of this series of 
Labs.  If you haven't worked through Lab01, please do this first.  The instruction in this Lab depends on 
the correct setup of a connection to an IBM i server. 
 

 

Note: 
PAYROLLG is the same RPG program as PAYROLL but without 
compile errors. You are using it instead of PAYROLL in this lesson, to 
accommodate anyone who decided to skip right to this Lab, without 
completing Lab02 or Lab03. 

 
 
To make the lesson more interesting you will use CL program CLR1 to call PAYROLLG and you will 
pass one parameter to CLR1. 
 
In this lesson, you will use a service entry point to start a debug session for your application.  The Service 
Entry Point feature is designed to allow easy debugging of applications on IBM i that invoke business 
logic written in RPG, COBOL, CL, C, or C++.  The service entry point is a special kind of entry 
breakpoint that can be set directly from the Remote Systems Explorer.  It is triggered when the first line of 
a specified procedure is executed in a job that is not under debug.  Service entry points allow you to gain 
control of your job at that point.  A new debug session gets started and execution is stopped at that 
location. 
 

2.1 Changing the Update Production File preference 
 

 

Note: This section is for your information only, continue to the next section to start 
the exercises.  

 
 
We first describe how to change the debug preference to allow update of Production libraries during a 
debug session.  This preference is by default set to not allow update of production libraries. 
 
For this exercise you don't have to change this preference but here are the steps to follow when you work 
with production libraries in your own environment. 

To set the i Debug preference in the workbench:  
__1.  Click Window > Preferences 
__2.  Expand Run/Debug  
__3.  Select IBM i Debug 

 

The picture can't be displayed.

The picture can't be displayed.
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Since you are using test libraries for these exercises, you don’t have to change this IBM i Debug 
preference to “Update production files”. 
 
 

2.2 Set Service Entry breakpoint 
 
Now let's begin with starting the debug session using a service entry breakpoint: 
__1.  In the Remote Systems view expand the Library list filter, if it isn’t expanded already. 
__2.  Expand library RSELABxx, if it isn’t expanded already. 
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__3.  Right-click program CLR1 in library RSELABxx. 
 

 
 

__4.  Click Debug or Code Coverage (Service Entry) > Set Service Entry Point (Prompt) on the 
pop-up menu to set a service entry point. 

 
  

 

Note:  
If you selected the unprompted menu item, the service entry breakpoint would be 
triggered, and you would be placed in the debugger whenever the CLR1 program is called 
no matter the value of the parameter. 

 
 
 We are going to specify a condition so that we are only placed into the debug when &num is 

equal to our team number. (make sure the &num is set to your two-digit team number 
corresponding to your RSELABXX library) 

 

The picture can't be displayed.
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A message displays indicating the service entry point was successfully set. 
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Troubleshooting 
If you get this error message instead, 
 

 
 

indicating that the Debug Server has not been started yet. Click Yes 
button to start the Debug server. 

 
 

 
The Service Entry Points view is automatically added to the stacked views below the edit 
view. It lists all service entry points setin this workbench instance. You use this view to delete, 
activate, de-activate, modify and refresh service entry points. 
 

 
 

__5.  Note you can see the condition you specified. To modify the condition, right-click the condition 
you want to modify and click ‘modify’.  

 

  
 
 
 
 
 
 
 

The picture can't be 
displayed.
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__6.  For our purposes, we do not want to change the condition, so click ‘Cancel’. 
 

  
  
__7.  Switch to a 5250 emulation session. 

 
 

 

Troubleshooting 
If you have done the exercises in Lab03, your 5250 session might still be 

associated with the RSE server job and you will need to release the 

interactive session. To do so, in the Remote Systems view, right-click 

Objects and click Release Interactive Job on the pop-up menu. 

 

 
On the command line of the 5250 screen, add the library RSELABxx to the library list and invoke 
the program CLR1, by entering the following commands: 

The picture can't be displayed.
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__8.  ADDLIBLE RSELABxx (with xx your team number). 
 

 
 

__9.  First, we will call the program with a parameter other than your team number so that it will not 
trigger the SEP breakpoint. Enter CALL PGM(RSELABxx/CLR1) PARM(‘AA’) (with xx your 
team number) 

 

 
  
__10.  Note that we did not hit the debugger because the SEP condition is not fulfilled, hit F3 to quit.  

 

 
 
Notice the condition on the SEP allows us to avoid being put into the debugger for a different 
team number than our own.  

The picture can't be displayed.
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__11.  Now, let’s call the program with your team number so that the SEP condition will be triggered. 
Enter CALL PGM(RSELABxx/CLR1) PARM( ‘xx’) (where xx is your team number).  
 

 
 
__12.  A Confirm Perspective Switch dialog may appear:  

 

 
 
If so, confirm by clicking Yes. 
 
As soon as the program enters the system, the service entry point is hit, and the debug session is 
started on the workstation and the perspective displays with the CLR1 source code in the editor. 
The Debug perspective gives you access to all available debugger features. Let’s look at some of 
them. 
 

__13.  Click anywhere in the workbench to give it focus. 
 

 

2.3 Setting breakpoints 
 
You can only set breakpoints at executable lines.  One way to set a breakpoint is to right-click on the line 
in the Source view. 
 
To set a breakpoint: 
__1.  Position the cursor on line 11. 
__2.  Right-click anywhere on line 11. 

The picture can't be displayed.
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__3.  Click Add/Remove Breakpoint on the pop-up menu. 
 

 
 
A dot with a check mark in the prefix area indicates that a breakpoint has been set for that line. 
The prefix area is the small grey margin to the left of the source lines. 
 
Now you add a conditional breakpoint to stop in the loop when it loops the 99th time. 

2.4 Adding a conditional breakpoint 
 
__1.  Select line 8. 
__2.  Click the Breakpoints tab in the upper right pane of the Debug perspective. 

The Breakpoints view opens. 
__3.  Right-click anywhere within the Breakpoints view. 
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__4.  Click Add Breakpoint > Line on the pop-up menu. 
 

 
 
The Add a Line Breakpoint window opens. 
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__5.  Click Next. 
 

 
 
 

 

Tip: 
You can select an existing breakpoint by right-clicking it and selecting Edit 
Breakpoint. 

 
 
You only want to stop in the loop when it executes for the 99th time or more.  You can do that by 
setting the From field of the Frequency group to 99. 
 

__6.  Under Frequency in the From field, type 99. 

The picture can't be displayed.
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__7.  Click Finish. 
 

 
 
You have added a breakpoint including a conditional breakpoint to your debug session. 

 

2.5 Monitoring variables 
 
You can monitor variables in the Monitors view.  Now you will monitor the variable &count. 
To monitor a variable: 
 
__1.  In the Source view, double-click the variable &count. 
__2.  Right-click &count. 

The picture can't be displayed.
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__3.  Click Monitor Expression on the pop-up menu. 
 

 
 
The Monitors view opens. 
The variable appears in the Monitors view. Its current value is zero. 
 

 
 
Now that some breakpoints and a monitor are set, you can start to run the application. 
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__4.  Click the Resume icon on the Debug toolbar. 
 

 
 
The program starts running and stops at the breakpoint at line 8.  Be patient, the Debugger has to 
stop 98 times but because of the condition continues to run until the 99th time.  Notice in the 
Monitors view, that &count now has the value 99. 
 

__5.  Click the Resume icon again. 
The program stops at the breakpoint at line 8 again and &count now has the value 100. 

__6.  Click the Resume icon once more so that the program runs to the breakpoint at line 11. 
__7.  If you do not see the error message below, go to “Stepping into a program” topic 2.7. 

 
 

2.6 Error handling 
 
If you don't have any errors, skip to the next section 'Stepping into a program' 
If you forgot to add the parameter to the CALL program command when calling the program, you will see 
this error message. 
 

 
 
__1.  Click OK on the error message dialog. 
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__2.  Click the Terminate icon (      ) on the Debug toolbar 
The debug session terminates on the workstation but the exception waits for input from the 5250 
emulation session. 
If you closed the Debug view by mistake, you will need to re-open the Debug view and then 
terminate the debug session on the workstation. 
 
Here are the steps to re-open the debug view: 

__3.  Click Window > Show View > Debug. Click Other.. if Debug is not on the list, type Debug in 
the text box to filter out the options. Select Debug under Debug will open the view.  

 

 
 
 
Now terminate the Debug session if you haven’t done so already. 

__4.  Go to your 5250 emulator. 
__5.  Enter C for cancel and press Enter until the program messages complete. 
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In the workbench: 

__6.  Click the Remove all terminated launches icon on the Debug toolbar to clean up the Debug 
view. 
To restart the program and start the debug session again. 
On the 5250 command line, call the CLR1 program with the parameter xx. 

__7.  Enter: CALL PGM(RSELABxx/CLR1) PARM(’xx’) where xx is your team number. 
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2.7 Stepping into a program 
 
The Debugger allows you to step over a program call or step into it.  When you step over a program call, 
the called program runs and the Debugger stops at the next executable statement in the calling program. 
You are going to step into the PAYROLLG program. 
 
To step into a program: 
__1.  Click the Step into icon on the Debug toolbar. 

 

 
 
The source of PAYROLLG is displayed.  Depending on the option you used to compile the 
program (*SRCDBG or *LSTDBG for RPG, or *SOURCE, *LIST, or *ALL for ILE RPG), 
this window displays either the Source or Listing View. 
If you specified an incorrect parameter for the CALL program command, or your library list 
does not include RSELABxx, you will see this error message. 
 

 
 
Make sure your library list is correct and complete the same steps as covered in the section called 
Error Handling in topic 2.6. 
 

The picture can't be displayed.
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__2.  Right-click anywhere in the Source view and click Show view > Show *LISTING on the pop-up 
menu. 
 

 
 

__3.  Page down in the source and take a look at the expanded file descriptions. 
You don’t have any /Copy member in your PAYROLLG program, but these would also be shown 
in a Listing view.  Switch back to the Source view. 

__4.  Right-click anywhere in the Source view. 
__5.  Click Switch view > Show *SOURCE on the pop-up menu. 

You have stepped into PAYROLLG program, switched the view from source to listing and back 
to source. 

 

2.8 Listing call stack entries 
 
The Debug view in the upper left pane, lists all call stack entries.  It contains a tree view for each thread. 
The thread can be expanded to show every program, module, and procedure that is on the stack at the 
current execution point.  If you double-click on a stack entry you will display the corresponding source if 
it is available.  Otherwise, the message No Debug data available appears in the Source view. 
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__1.  In the Debug view, expand the stack entry of Thread1 if it is not expanded already. 
 

 
 
The stack entry allows you to work with and switch between different programs and/or ILE 
modules. 
 
You have viewed the call stack entries of your program. 

 

2.9 Setting breakpoints in PAYROLLG 
 
Now you add some breakpoints in PAYROLLG. 
 To add breakpoints: 
 
__1.  Select PAYROLLG in Thread1. 
__2.  In the source view scroll to line 57. 
__3.  Double-click the prefix area (to the left of the source code line number) of line 57. 

A breakpoint icon is added to the prefix area of this line to indicate that a breakpoint is set. 
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__4.  Repeat the above step for line 58. 
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__5.  Right-click in the prefix area of line 87 and click Add/Remove Breakpoint on the pop-up menu. 
 

 
 
To view all breakpoints, select the Breakpoints tab from the top left pane: 
 

 
 
This view shows all breakpoints currently set in your Debug session.  This is a convenient place to 
work with breakpoints.  You can remove, disable/enable, add, or edit a breakpoint.  These tasks are 
available from the pop-up menu when you right-click in the view area.  Double-click any entry to 
show the source where the breakpoint is set. 

2.10 Removing a breakpoint in PAYROLLG 
 
It is also easy to remove breakpoints. 
To remove a breakpoint: 
 
__1.  Right-click the prefix area of line 58. 
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__2.  Click Add/Remove Breakpoint on the pop-up menu. 
 

 
 
The icon is removed from the prefix area indicating that no breakpoint is set on that line.  The 
breakpoint is also removed from the list in the Breakpoints view. 
 
 

 

Tip: 
Double-clicking on a breakpoint in the prefix area will also remove that 

breakpoint. 

 
 
Now you are ready to run the PAYROLLG program. 

__3.  Click the Resume icon ( ) from the Debug toolbar. 
The program starts running and runs to the breakpoint at line 57. 

The picture can't be displayed.
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__4.  Click the Resume icon again. 
The program waits for input from the 5250-emulation session. 
 

 
 

__5.  Type an X beside the Project Master Maintenance option. 
__6.  Press Enter in the emulation session. The program runs to the breakpoint at line 87. 

You have removed a breakpoint from PAYROLLG and started to run the program. 
 

2.11   Monitoring variables in PAYYROLLG 
 
Now let’s monitor variables and change them in PAYROLLG. 
To monitor variables: 
__1.  In the source view, double-click the variable EMPAPL on line 88. 
__2.  Right-click the variable. 
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__3.  Click Monitor Expression on the pop-up menu. 
 

 
 
 

__4.  Click the Monitors tab in the upper right pane.  The variable appears in the Monitors view.  Its 
value is blank because you did not select the Employee Master Maintenance option. 

__5.  In the same way add the variables PRJAPL on line 91 and RSCDE on line 113 to the monitor. 
Variable PRJAPL equals X because you did select the Project Master Maintenance option. 

__6.  In the Monitors view, double-click the variable RSCDE. The value changes into an entry field. 
__7.  In the entry field, type in the new value X for the variable. 

 

 
 

__8.  Press Enter. 
The variable is successfully changed. 
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2.12 Adding a memory monitor 
 
Adding a memory monitor for a variable allows you to view the memory starting with the address where 
the variable is located.  The memory can be displayed in different formats, for example hexadecimal and 
text. 
 
To add a memory monitor: 
__1.  In the Source view, double-click the variable ERR in line 33. 
__2.  Right-click and select Monitor Memory > EBCDIC on the pop-up menu. 

 

 
This will open the Memory view in the pane at the bottom of the perspective.  The tab shows 
the name of the variable. 
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__3.  Use the scroll bar on the right of the Memory view to scroll down.  You can see the current 
content of the memory. 

__4.  Right-click in the view area. 
__5.  Click Reset to Base Address on the pop-up menu to return to the starting address. 
__6.  To get the hex content of the memory starting with the selected variable, click the tab New 

Renderings and select Raw Hex for example.  A new page with the hex values is added to the 
Memory view. 
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__7.  Click the Toggle Split Pane icon to display the character values as well. 
 

 
 
You have added a memory monitor for the variable ERR. 

 

2.13 Setting Watch breakpoints 
 
A Watch breakpoint provides a notification to the user when a variable changes.  It will suspend the 
execution of the program until an action is taken. 
 
To set a Watch breakpoint: 
__1.  Go to the Line number field at the bottom of the source area.  In this field enter 116 to go to 

that line. 
__2.  Double-click variable *IN60 to highlight it. 
__3.  Right-click and click Add Watch Breakpoint on the pop-up menu. 



IBM Software 

Page 34 IBM Rational Developer for i Sandbox – RDi Lab 04 - Debug 

 
 
The Add a Watch Breakpoint window opens. The Expression field is pre-filled with the 
highlighted variable *IN60.  By default, the Number of bytes to watch field is set to zero, which 
means the variable will be watched in its defined length. 
 

 
 

__4.  Click Finish. The Watch breakpoint is now set. 
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__5.  Click the Resume button on the Debug toolbar. 
The application waits for input from the 5250-emulation session. 
 

 
In the 5250 emulation session, type: 

__6.  123 for Project Code and D (for delete) in the Action Code field. 
__7.  Press Enter. 

A message is displayed indicating that the variable *IN60 has changed. 
 

 
 

__8.  Click OK. The program stops at line 465. This line is located immediately after the statement 
which caused the variable *IN60 to change. 
 
You have added a Watch breakpoint for the variable *IN60 and run the program to see the 
notification that the variable has changed. 

 

2.14 Terminate a debug session 
 
To close the debugger: 
__1.  Click the Resume icon on the Debug toolbar. The application waits for input from the 5250 

emulation session. 
__2.  Switch to the 5250 emulation session. 
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__3.  Press F3 to end the program. 
A message Program terminated appears: 
 

 
 

__4.  Click OK. 
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3 Debugging a Job 
 
In addition to being able to debug a program, you can also debug a job. 
To debug a job: 
In the Remote Systems Explorer perspective, under your active server connection, IBM i Test 
System: 
__1.  Expand Jobs > My Active Jobs > QBASE. 

If you cannot find the job in QBASE, then try to expand Jobs > My Active Jobs > QINTER. 
 
__2.  Right-click the active job under QBASE (or QINTER) and select Debug As > IBM i Job. 

 

 
 
The debug session begins and connects you to the running application. 
You can set breakpoints, monitor variables and memory in the same way you did before. 
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__3.  Terminate the debug session by right-clicking the job in the Debug view and selecting Terminate 
from the pop-up menu. 
The debug session is terminated. 
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4 Lab summary 
 
In this module, you learned how to debug a program using the Integrated IBM i Debugger. 
 
Lessons learned 
• Start a debug session using service entry points 
• Add a breakpoint 
• Add a conditional breakpoint 
• Edit a breakpoint 
• Monitor a variable in the Monitors view 
• Step into your payroll program 
• Show a Listing view 
• Display source from call stack entries 
• View all breakpoints 
• Remove a breakpoint 
• Monitor memory 
• Set a Watch breakpoint 
• Close the debugger 
• Invoke the debugger from a Debug Configurations window. 
 
This tutorial has taught you so far how to maintain a payroll application using the Remote Systems 
Explorer.  You learned how to start the product and open the Remote Systems Explorer perspective and 
how to use tools and views in this perspective to connect to an IBM i system and edit, verify, compile and 
debug the payroll application. 
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Congratulations! 
 
You have successfully completed the Debug lab exercises. 
 
We recommend that you move on to the next lab in the sequence; or browse the list of labs on Rational 
Developer for i - Hands-On Labs at http://ibm.biz/rdi_labs to choose a lab of interest. 
 
More information, material and opportunities to discuss the product can be found at our RDi Hub:  
 
http://ibm.biz/rdi_hub 
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Appendix A  Notices 

This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently available in 
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only 
that IBM product, program, or service may be used. Any functionally equivalent product, program, or 
service that does not infringe any IBM intellectual property right may be used instead. However, it is the 
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not grant you any license to these patents. You can send license 
inquiries, in writing, to: 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 
For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country or send inquiries, in writing, to: 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan 
The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES 
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. 
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of 
the materials for this IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 
Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
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been made on development-level systems and there is no guarantee that these measurements will be the 
same on generally available systems. Furthermore, some measurements may have been estimated through 
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those 
products. 
All statements regarding IBM's future direction and intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 
This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products. All of these names are fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. All references to fictitious companies or individuals are used 
for illustration purposes only. 

COPYRIGHT LICENSE: 
This information contains sample application programs in source language, which illustrate programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing 
application programs conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly tested under all 
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these 
programs.



IBM Software 

IBM Rational Developer for i Sandbox – RDi Lab 04 - Debug Page 43 

 

Appendix B  Trademarks and copyrights 

The following terms are trademarks of International Business Machines Corporation in the United States, 
other countries, or both: 

IBM AIX CICS ClearCase ClearQuest Cloudscape  

Cube Views DB2 developerWorks DRDA IMS IMS/ESA  

Informix Lotus Lotus Workflow MQSeries OmniFind   

Rational Redbooks Red Brick RequisitePro System i   

System z Tivoli WebSphere Workplace System p   

 
Adobe, Acrobat, Portable Document Format (PDF), and PostScript are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States, other countries, or both. 
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other 
countries, or both and is used under license therefrom. 
Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. See Java Guidelines 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in 
the United States, other countries, or both. 
Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, 
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its 
subsidiaries in the United States and other countries. 
UNIX is a registered trademark of The Open Group in the United States and other countries. 

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 
ITIL is a registered trademark and a registered community trademark of the Office of Government 
Commerce, and is registered in the U.S. Patent and Trademark Office. 
IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications 
Agency which is now part of the Office of Government Commerce. 
Other company, product and service names may be trademarks or service marks of others. 
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warranty of any kind, express or implied.  IBM shall not be 

responsible for any damages arising out of the use of, or otherwise 

related to, these materials.  Nothing contained in these materials is 

intended to, nor shall have the effect of, creating any warranties or 

representations from IBM or its suppliers or licensors, or altering 

the terms and conditions of the applicable license agreement 

governing the use of IBM software. References in these materials 

to IBM products, programs, or services do not imply that they will 

be available in all countries in which IBM operates. This 

information is based on current IBM product plans and strategy, 

which are subject to change by IBM without notice.  Product 

release dates and/or capabilities referenced in these materials may 

change at any time at IBM’s sole discretion based on market 

opportunities or other factors, and are not intended to be a 

commitment to future product or feature availability in any way. 

IBM, the IBM logo and ibm.com are trademarks or registered 

trademarks of International Business Machines Corporation in the 

United States, other countries, or both. If these and other IBM 

trademarked terms are marked on their first occurrence in this 

information with a trademark symbol (® or ™), these symbols 

indicate U.S. registered or common law trademarks owned by IBM 

at the time this information was published. Such trademarks may 

also be registered or common law trademarks in other countries. A 

current list of IBM trademarks is available on the Web at 

“Copyright and trademark information” at 

ibm.com/legal/copytrade.shtml 

Other company, product and service names may be trademarks or 

service marks of others. 

 

 


